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Using ToolBook to Create Standards-Based Content

Using ToolBook to Create Standards-Based Content

This tutorial shows you how to use ToolBook to create Web content containing an assessment that can
be deployed with a Learning Management System (LMS) using the SCORM learning standard. For
additional information, please refer to ToolBook’s online help system or contact SumTotal Systems.

Installing ToolBook

Use the installation instructions provided to you in the initial email from SumTotal Systems.

Creating a New ToolBook Book

With ToolBook, you build a learning application by starting a book and adding content such as text,
graphics, assessments, software application simulations, and interactive objects. One way to start a new
book is to use the Book Wizard, which supplies a graphical theme and other objects for the book based
on choices you make in the wizard.

» To start a new book:

1. Open ToolBook. From the Start menu, point to Programs, ToolBook 11, and then click ToolBook
11.

2. Inthe ToolBook Startup dialog box, click Use A Book Wizard.
T ToolBook 11 Startup

fEem Book Use a Book Wizard
Blank The Book Wizards automate the task of creating the layout for a ToolBook
From a Template lesson. These wizards gather input from you about how you want the book

|UseaE|Dth'|l’|zarﬁ 1 to appear and behave.

Open Book
Select a File
Recently Opened Books

Available Types

e Hesotees [ Book Wizard

Getting Started Lesson Design Wizard
Learning / Training

Use the Book Wizard fo creste a book or template based on your
specifications. This Wizard builds 2 book that reflects your input about
page style, and outline for page organization.

Start Wizard

3. Choose Book Wizard from the Available Types, and click Start Wizard.
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4. Inthe Book Wizard, read the first page and then click the Next button.
Book Wizard E|

I|| Book Wizard

The Book Wizard creates the foundation for an orling learning application.

Oni the next few pages, you specify a page style, scoring and logging options, and other
zettings that affect the appearance and behavior of your application. ToolB ook then
creates a book based on pour specifications that you can custonize by adding your own
content.

“V'ou can modify your application at any time by adding text, media clips. hyperlinks.
I interactive objects, and scripts.

Cancel |

5. On the General Information page, enter a title for this book, and then click the Next button.
Book Wizard E|

General Information

Book title:
My course

Book dezcription, copyright, or other information:
Copyright SumT otal Systems

Lthor:
Aaran Smith |

Mext » | Cancel |
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6. On the Page Style page, select Solar in the Page style box. Click the Show preview checkbox to
see a thumbnail image of the style.
Book Wizard r5_<|

Page Style B

A page style determines the araphics and layout.

Fage ztyle: Previgw:
5% Bruzhed Steel (IPhone Portrait) ﬂ
55 Brushed Steel

=% Cumy

55 Fire

5% iPhone (iPhone Landscape)

5% iPhone (iPhone Portrait)

55 Mint

5% Rainbow |
=% Soft Blue [iPhone Portrait) =
55 Soft Blue

% Salar [iPhone Landzcape)
5% Solar [iPhone Portrait

Iv  Show preview
File: Salar.ptp 09/08/2009 23:25: 48

5% Synapse —

Page style directony;
| C:\Program Files\T oolB ook T oclBook 1045 pelstiStyles' =

Last | < Back | Hext » || Cancel |

7. Onthe Book Type page, select the Standard Book option.

Book Type

You can create a randomized quiz or & more book, containing more general content,

" Standard Book

If pou chiooze this option, you will be able to select from a list of available book outlines or create a custom book
outline.

¢ Quiz Book
If pou chooze this option, ToolBook Instructar will create a simple quiz book with & question on each page.

Lazt ¢ Back Cancel
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8. On the Book Outline page, select the Simple Quiz option in the outlines list.
Book Wizard f5__<|

Book Qutline

A boaok outline specifies the types of pages vour application will contain,

Select a predefined book, outling below, or create a cuztom outline,

Defined book outlines: Book gutline:

Simple Training Objectives [Text)

Skill Training Interaction [Multiple Choice Question)

Soft Skillz Training Interaction [Tre-Falze Quastion)

<Cuztom Outline: Interaction (Fill in the Blank Queztion)

<Mo Outlines - Quiz Summary [Quiz Summary with Print Button) -
Simple Quiz Outline - Pravides a basic structure for a A page with & zingle media player. Use thiz page to
qQuiz. present a title, author creditz, and copyright information.

If you want to digplay a compary logo, drag a graphics
placeholder object from the Catalog and drop it on this
page.

Outhire directon:
Ch AT oolBookhT oolB ook, 1045 pelsts Outliness ﬂ

Last | < Back | Mext » || Cancel |

9. On the Page Size page, choose Default page size for style.
Book Wizard rg

Page Size

Select the zize of pages in vour application,

@ Default page size for style
Select thiz option to use the optimal page zize for the style you selected,

" Full screen
Select thiz option ta have your application dizplay at full screen.

¢ Custom page size  [800 & B00 pixels)
Select thiz option to size your application by page units or pisels.

Cancel

Last < Back
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10. On the Scoring page, make sure that the Record score checkbox is checked.
Book Wizarnd ['5_(|

Scoring
Chiooze whether the course will be scored, and where to send the scare,

¥ |
Select thiz option ta enable zcaring during the course session. Usze the optiohs below to specify whao receives
scoring information.

[ E-mnail resulks to studest
[~ E-mail results ba:

[ |

Last | < Back | Mest > || Cancel |

11. On the Logging page, ensure that the Enable logging option is unchecked.

Logging

Chooze whether question answers will be logged. and where to send the log.

[ Enable logging
Select thiz option to enable logging during the course session. Use the options below to specify who receives
the lagaing infarmation.

r

[ |

Last < Back Cancel
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12. The next page of the wizard shows you a summary of the options you’ve selected. Click the Build
button to build your book.

Book Wizard g|
Summary

Book Title Wizard Action: Set Infa_Title property of the boak to My course

Descnption “Wizard Action: Set Info_Description property of the book to Copyright SumT otal
Swstems

Page style file C:\._ASpclsthStyles\Solar.ptp
[File frorm which the page styles are drawn)
Solar

Book Outline
Simple Quiz Outline - Provides a basic structure for & quiz.

Page Size Default Size
This application is shown at the default template size.

Copy | Frint |

| < Back | Build | Cancel |

13. Your new book opens with the Catalog displayed on the left side of your window.

*F ToolBook - (Untitled) (=13
File Edit View Go Insert Object Text Draw Tools Help
gH 0 @ = R=EE I &

Commonly Uzed Objects

3 =
ES—

Auto-Sizing Text Image
Fiel

3

% LESSONTITLE%

[%CHAPTERTITLE%

-
It

=t Lok ]
Bl

2 TOPICTITLE %
Universal Media SmartStyle Button = B o 3 = R
Player Lorern ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod ternpor incididunt ut labore et
v dolare magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullameo labonis nisi ut aliquip:
Aclion Ohjscts = ex ea commodo consequat. Duis aute irure dolor in reprehenderit in voluptate velit esse cillum dolore

eu fugiat nulla pariatur, Excepteur sint occaecat cupidatat non proident, sunt in culpa qui officia

Buttans deserunt mollit anim id est laborurm.

Certificates
Draw Dbjects
Media F'Ia‘yers
Mavigation Objects
Pages 7
Placeholder Objects

. t!uasn;ns
Q‘uwz Summary
Sl A

Simulation Objects

Click Next fo confinue.
Styles

Text Fields
TatalLM s
My Objects

[Pae"Tie" [iisEsa | @ |8 [0 109 B
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Modifying an Existing Question

The course used in this tutorial already has a page with a question in it. Of course, you can add questions

to any ToolBook page by selecting question objects from the ToolBook catalog. For this discussion, we

will use the question object already available on one of the ToolBook pages.

Define the Question Text

We will start with a True/False question that has been created for us by the Book Wizard and change it

into a Yes/No question.

» To replace the question text:

1.
2.

3.

Navigate to page 4 by clicking the right arrow in the status bar at the bottom of the page.

On page 4, click once on the text that starts with “Lorum ipsum”. Selection handles will appear
around the sides of the text box. Double-click on the same text and the insertion cursor appears,
allowing you to enter text.

P ToolBook - (Untitled) CEX

File Edit Wiew Go Insert Object Text Draw Tools Help
SH 0ol = K=ame 10| @
; ; ‘ 2
Commonly Used Objects )
7 = s
] = B 5
i — Yo LESSONTITLE %o
sl %CHAPTERTITLE%
=
Er 0 TOPICTITLE
Universal Media  SmanStyle Button = = -
Player [Type your guestion text here. Lorem ipsum dolar sit amet, cansectetur adipisicing elit, sed do eiusmod
- ternpor incididunt ut labore et dolore magna aligua
Action Objects
Buttors . @ s
tertificatas @ False
Draw Dbjects
Media Players
Mavigation Objects
.i:.a.g.e.s : i
Placeholder Objects
Questions
Quiz Summary
Scoiing and Tracking
.Sim.L;Ia.l.it.un .Dhi:acl.s. .
Styles T Click Submif fo check ypour amswer, then elick Next fo confinue.
Teut Fields
TotallMs
My Dbjects
[Pags ‘Insacion” [ 112654140 | | B @) 4cis [

Select the existing text and type in your own question text, such as: Does SumTotal Systems
have an office in Mountain View, CA?
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Change the Properties of the Question

It’s easy to change a True/False question into a Yes/No question by editing the question properties.

» To change the answers:

1. Select the True/False answer box by clicking once inside the answer area. Selection handles
appear around the box, as shown below.

T ToolBook - (Untitled)
File Edit View Go Insert Object Text Draw Tools Help

S cn/el aKk=EEe WD Ee 2 FIIFA BB %ML

P4
Commonly sed Objects

#uto-Sizing Text Image
Field

Universal Media SmartStyle Button
Player

Achion Objects
Buttons

Certificates

Diraw Objects

Media Players

Navigation Objects

Pages
Placeholder Objects

Questions

Quiz Summary

Scoring and Tracking

Simulation Objects

Styles

Tt Fields
TatalLMS
My Objects

[ 114454860 [ [ B [ 403 )

| Page "Interaction"

10
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3.

From the Object menu, choose Properties for True/False Question.

T ToolBook - (Untitled) EEX
File Edit

Sd o eyl

View Go  Insert Text Draw Tools

Ty U o442

Properties for Graup,.,, Shift+Fe

. Properties For Page... Shift+F7
Commonly Used Objects | Properties for Background... Chrl+F7
oL = Propetties for Book. .. Shift+Fg
M ﬁ Propetties For Lesson, .. Chl+FE FLE 0/
Auto-Sizing Tet Image Actions. .. F5 o
Field fiction Methads... CtriFS
Path Animation. .. Ctrl+shift+4
Hyperink. . Chrb+Shift+H
Universal Media SmanStyle Bung  Shared Actions... Shift+F5 : :
Player Resources... Chl+F10 in office in Mountain Yiew, CA?
F ]
Action Objects ) )
+ Ungroup Chrl+Shift+G
EButtons T dey e P
Certificates |
il :‘
Diaw Objects |
Media Players
MNavigation Objects
Pages
Placeholder Objects
Questions
Quiz Summary

Scaoring and Tracking

Simulation Objects
- Click Submit fo check your aviswer, then click Next fo confinue

Styles

Text Fields
Tnla‘l‘LivI‘S
dy Objects

Sets extended properties for the selected object,

In the Properties dialog box, click the Answers tab.

Properties for True/False Question

General Answers | Scoring | immediate Feedback | Delayed Feedback |

This type of True/False guestion is a group of two objects. You can change the text
or caption shown by the objects.

An Cancel

Help

False

[ Cor _ e |

[~ Cannot change response

[ Randomize answers

11
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4. Select True and click the Edit button to change the default text. Type the word Yes as the text
for the answer and then click OK.

Edit the Answer El
Text for this answer:
Yes

Cancel
Help
Comect

5. Inthe Answers box, select False, then click the Edit button. Type the word No as the text for the
answer in the Edit the Answer dialog box, and then click OK.

6. Click OK to close the Properties dialog box.

7. The answers for the question are now Yes and No.

T ToolBook - (Untitled)
File Edit Wiew Go Insert Object Text Draw Tools Help

G :n2@ oK=EE6¢ (1D @ FRIFZA|BBBAL

Commonly Used Objects

mm :‘ % LESSONTITLE%

Field %CHAPTERTITLE%

—
2 TOPICTITLE %

Universal Media  SmartStyle Button = = =
Flayer Does SumTaotal Systems have an office in Mauntain View, CA?

u
Action Objects es
Buttonz Mo i

Certificates

3]

|4

Drawe Objects
Media Flayers
Mavigation Objects
Pages

Placeholder Objects

Questions

Quiz Summary

Scoiing and Tracking

Simulation Objects
Clhick Submit fo check pour answer, thewn click Next fo confinue.

Styles

Text Fields
TotalLM5
ty Objects

| Page "Interaction” 100F5.8250 | [ 403 [¥)

Try Your Question

ToolBook makes it very easy to test your question to make sure it’s working properly. To do this, switch
to Reader Level, which shows you a preview of how the question will appear to the learner.

» To test your question:
1. Press F3to go to Reader Level.
2. Click either the Yes or No button to see the feedback.

3. Press F3 to return to Author Level.

12
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Adding Buttons to Send the Score to the LMS

Since questions are included in this course, we will want the score for the answers, as well as all other
end-user results, recorded in the LMS database. To do this, buttons need to be included in the course to
allow the user to signal course completion and the score to be sent to the LMS.

In the Scoring and Tracking category of the ToolBook Catalog, you will find exit buttons that will send
scoring information to the LMS, such as the Exit (Mark as Complete) and Exit (Suspend Lesson) buttons.

The Discard Results button can be included in your course if you want to give students the option of
exiting the course without sending scoring information to the LMS database. This course has a page
available that already has a button for sending results to an LMS. For this discussion, we will review the
button already available on one of the ToolBook pages.

Navigate to page 7 by clicking the right arrow in the status bar at the bottom of the page. Note that
there is already a button on this page to communicate with the LMS.

P ToolBook - (Untitled)
File Edit “iew Go Insert Object Text Draw Took Help
& W @ = K=m=Ee 10| de

Commonly Used Dbjects
Action Objects

3 Yo LESSONTITLE%o

m © Text % CHAPTERTITLE%

Cpen documnent  Bullet Text Lewel
1

S\ Text %

Bullet Text Level  Play Audio with
H Bullets 1 v

e TOPICTITLE %

Larem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et
dalore magna aligua. Ut enirm ad minim veniam, guis nostrud exercitation ullamco laboris nisi ut aliguip:
lex ea commodo consequat. Duis aute irure dolor in reprehenderit in voluptate velit esse cillum dolore

eu fugiat nulla pariatur, Excepteur sint occaecat cupidatat non proident, sunt in culpa gqui officia
deserunt mollit anim id est laborum.

Buttons

Certificates

Draw Objects
Media Players
Navigation Dbjects
i:'ages ]
F_’Iaceh_older Objects

Questions

Quiz Summary

Scaring and Tracking

Simulation Objects

Styles
Text Fields
TotalLMS
My Objects

| 11220185 O B [ 7o [

Note: As an alternative to using the pre-built catalog objects for sending scores to the LMS, the Exit
Lesson action available in the Actions Editor can also be used. Four possible parameters can be
used: Mark lesson as complete, Suspend lesson, Discard results, or Restart lesson. In addition,
the Execute SCORM option is also available in the Actions Editor. With this option, the SCORM
API can be called directly if desired. Please refer to the ToolBook online Help system for
additional information on the Actions Editor.

13
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Saving a ToolBook Book

Prepare your book for the next step by saving it.

» To save your book:

1. From the File menu, choose Save.

P ToolBook - (Untitled)
F0W Edit View Go Insert Object Text Draw Tools Help

New... D @e=EES2A|Ean

Qpen.., CEro
Cpen #ML Boak, .,

Save As... % |

Save As Template... -1 SONTITLE 0/0

Publish to web (DHTMLY...

©anim id est laborum

ITITLE%
Extensions... Ctrl+E
Bound System Books, ., Chrl+y

! o
Print Setup... ITILE A’
Print Pages. .. CtrHF dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et
Print Repart. .. aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip
— ) o consequat. Duis aute iture dolor in reprehenderit in voluptate velit esse cillum dolare
Ex't'” BEEEY pariatur. Excepteur sint occaecat cupidatat non proident, sunt in culpa qui officia

1 ¥:\httppost. tbk
2 i {Untitled). thk
3 Dithttppost.thlk
4 C:\Program Files\ToolBaoki ToolBaok 10.5scrwalk.thk

v e
Pages
Placeholder Objects

Questions

Quiz Summary

Scoring and Tracking

Simulation Dbjects

Styles

.T et Fields
TotalMS.
My Objects

Saves the current book.

2. Select OK when the Reset options dialog is displayed.

Save As &|

Sawve options

pag jects to make them ready
to run, then save the book in that state. S
" Quick save Help

Save without resetting anything.

3. Typein afile name. For this example, use the name Test.tbk. Select Save.

14
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Publishing the Course as SCORM Content

After you finish building your course in ToolBook, prepare it for distribution by choosing Publish to Web
from the File menu. This opens the Web Specialist, which is a wizard that prompts you for information
to deliver your book as a series of HTML files deployable as a complete, ready to run SCORM package.

» To export a book for the Web and enable SCORM communication with an LMS:
1. From the File menu, select Publish to Web (DHTML).

T ToolBook - Test.tbk
G Edit Wiew Go Insert Object Text Draw Toals Help

=EEo 1D @eE|FINZA Ha s AL

pen,., Chrlo
Cipen XML Book...

Save Chrl+5
Save As...
Save As Template, .,

| Pub (DHTML)
Extensions... ChrHE
Bound System Books. .. Chrh+
Print Setup...
Print Pages, .. ChrHP

Print Report,.,

Run,..
Exit Alt+F4

1 \:\Test.thk

2 ‘iihttppost, kbl

3 ¥:\{Unkitled), tbi

4 \:\Gadgets InclGadgets Inc.tbk
v

Pages
Placeholder Objects

Ouestions

Quiz Summary

Secoring and Tracking

Simulation Objects

Styles
Teut Fields
Totall 5
My Objects

Publishes the curent book ta the web

15
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2. The ToolBook Web Specialist appears. Select the Expert button.

Welcome to the ToolBook Web Specialist.

This specialist will guide vou through the steps necessary to prepare pour
I I application for distribution on the W arld \wide ‘Wb,

Ta contitiue with the wWeb Specialist, click Mext.

If wou are cornfortable with the export options, click Expert.

Espert

Caticel |

3. Onthe next wizard page, choose to Process your application. Click Next.

Select the operations you wizh to perform below and click MNest.

[ Tranzter your application to a server

l | [v Process wour application

Esport Mow ¢ Back Cancel

16
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4. Choose which browsers you would like to support, and to publish all pages at once. Click Next.

ToolBook Web Specialist

Dresired browser support:

3

Micrazaft Internet Explorer 7.0 and later

[ Microsaft Intemet E=plarer 6.0

Firefox 3.0 and later

[ Firefox 2.0

O 2pple iPhone and iPod Touch 2.0 and later
O pple iPad 3.2 and later

[ Safari 2.0 and later

O Google Android 1.6 and later

[ tabile Internet Explorer 6.0 and later

Create HTML files in:

|"r’:\WebExport\

Fage Range
o Al " Curment page
" Pages:

Enter page numbers and/or page ranges separated by commas.

Enample. 1.3.5-12
r

Ewport Mow | < Back |

Caticel

5. You will be prompted to create a folder, Click Yes.
Publish to Web

N

' WWebExpart),

does not exist. Do you want to create it?

X

l

[ ]

6. Next, you are asked if the ToolBook course will be used with an LMS. Select the following

settings and click the Next button.

In the Package for option, select SCORM 1.2, or if you are using the SumTotal Systems
LMS, select the Total LMS (SCORM 1.2) option.

Select the Compress the exported files into a Package File option. By selecting this option,
a SCORM package file will be created that can be used to publish the course to the LMS.

17
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ToolBook Web Specialist E|
Package for: [SCORM 1.2 |

Generate A|CC Courze Descnptor Files
Use signed applet for AICC and HTTP Post
Lompress the exported files into a Package file

<1 717171

Uz double-byte character encoding

Uze pixel zizing for fonts

Enfarce hotword colors

LCorrvert tooltips to alternate test attibutes
Create CD-ROM Autoplay files

Dizplay diagnostic information in web browser [Debug Mode]
Stop if an error iz detected

U S O A B R B Y

Log emors to
['¥:\Test.dhtmllog |

Help Exportﬂow| < Back | Mest > | Cancel |

7. When the wizard prompts you about the Start page, leave the default options alone. Select
Next.

ToolBook Web Specialist &|

Start Page
e Automatically create an HTML page:

. l | v Include ook tite

[¥ Include book description
[ Include book, authar

Text color: - - |
Background: [ |~ |

Logao graphic:
|<SumTotaI Logo: ﬂ

" Use a custom HTML page:
| &l

™ Do hot use an HTML launch page

Help Esport Mow ¢ Back

Caticel

18
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8. Inthe page with options for content loading, leave the default options alone. Click Export.

ToolBook Web Specialist

Help

Contert Loading Page
@ |ze the default meszage

" Customize load message and graphic

X

| =
Advatced Options
v Obfuzcate JavaScrpt exported from Actions E ditar
¥ EncryptJavaScript parameters [Question Answers]
[ UseJava to decpt parameters
¥ Bename media files to guaranbes uniqueness
< Back Cancel |

9. The Publish to Web Progress dialog box appears. During this process, ToolBook is creating the
HTML pages for the course and inserting the appropriate SCORM communication. After the

export process is finished, click Next.
ToolBook Web Specialist

X

Mo that your application has been exparted, you can preview it in a web browser.
Choose a Browser

PBreview

¢ Back

Caticel |

Note:

To view the content in a Web browser, click the Preview button. If you select the

Preview button to preview the Web content, be sure to come back to this Wizard panel

and click Next so the publishing process can continue.

19
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10. A wizard pane is displayed indicated that ToolBook is ready to produce the SCORM Package file.

Select Next.
ToolBook Web Specialist fg|
The“#eb Specialist iz now ready to create the Package File.
| Click the Mest button below to begin.
1

11. After the packaging process is complete, a summary page displays. Click the hyperlinks to open
the folder containing the course, or to open the folder containing the zipped package file. Then
select Done to complete the Publish to Web process.

20
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Conclusion

We hope that this guide has been helpful. If you have any questions about using ToolBook, please
contact SumTotal Systems.
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